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Resumen 

El Embalse artificial Las Parcelas se encuentra ubicado en el corregimiento El Tomate del 

municipio de San Pedro de Urabá, el cual por condiciones de orden público y conflicto 

armado sufrido en la zona en las décadas de los 80 y 90 presenta un vacío de información 

respecto a su llenado y operación, histórico de niveles de agua, características morfológicas 

e hidrológicas antecedentes y precedentes, importantes para conocer y garantizar una 

adecuada gestión del recurso hídrico en función del uso estratégico de este cuerpo de agua; 

principalmente porque el embalse Las Parcelas en el momento es la única  fuente de 

abastecimiento operativa que brinda y garantiza el suministro de agua por gravedad al sistema 

de acueducto de este corregimiento, optimizando costos operativos y energéticos frente a 

otras alternativas disponibles en la zona. Por lo anterior, esta investigación tiene como 

objetivo identificar la ventana de tiempo de llenado del embalse, analizar la evolución y 

variación del espejo de agua y su potencial volumen de almacenamiento entre los años 2004 

y 2024 utilizando imágenes satelitales de la misión Landsat y de un modelo de elevación 

digital (DEM) de NASADEM, obteniéndose como resultado el periodo en el cual se comenzó 

a llenar el embalse, la identificación de los meses en los que se alcanzaron los volúmenes y 

cotas críticas máximas y mínimas, estableciendo una relación entre las variables altura de la 

lámina de agua y potencial de almacenamiento. 

Palabras Clave: imágenes satelitales, modelo de elevación digital, volumen, embalse 

artificial, nivel de agua, Google Earth Engine, abastecimiento, teledetección, Índice de Agua 

de Diferencia Normalizada (NDWI). 

Abstract 

 

The Las Parcelas artificial reservoir is located in the El Tomate district of the municipality 

of San Pedro de Urabá, which due to conditions of public order and armed conflict suffered 

in the area in the decades of the 80s and 90s presents a lack of information regarding its 

filling and operation, historical water levels, morphological and hydrological characteristics, 

antecedents and precedents, important to know and guarantee adequate management of the 

water resource based on the strategic use of this body of water; mainly because the Las 

Parcelas reservoir is currently the only operational supply source that provides and 

guarantees the supply of gravity water to the aqueduct system of this township, optimizing 

operating and energy costs compared to other alternatives available in the area. Therefore, 

this research aims to identify the reservoir filling time window, analyze the evolution and 

variation of the water mirror and its potential storage volume between the years 2004 and 

2024 using satellite images from the Landsat mission and a digital elevation model (DEM) 

from NASADEM, obtaining as a result the period in which the reservoir began to fill, the 

identification of the months in which the volumes and maximum critical levels were reached 

and minimum, establishing a relationship between the variables height of the water table and 

storage potential. 

Keywords: satellite images, digital elevation model, volume, artificial reservoir, water level, 

Google Earth Engine, supply, remote sensing, Normalized Difference Water Index (NDWI). 

 



 

1. Introducción 

El embalse artificial Las Parcelas se encuentra ubicado en el municipio de San Pedro de 

Urabá específicamente en el corregimiento El Tomate el cual cuenta con 7 veredas, limitando 

al norte con el municipio de Arboletes, al oriente y al sur con el corregimiento de Santa 

Catalina, y al occidente con el municipio de Turbo. El corregimiento El Tomate posee un 

área de 56,1 km2 y una población de 1151 habitantes (Gobernación de Antioquia, sin fecha), 

los cuales se abastecen de agua de este embalse artificial localizado en las coordenadas 

geográficas 76°23'5.20"O;   8°26'21.53"N, con un área aproximada de 15 hectáreas y una 

profundidad cercana a los 15 metros. 

 

Los embalses son reguladores de las dinámicas hidráulicas además de que funcionan como 

alternativa de almacenamiento de agua para diferentes usos, ya sea doméstico, industrial, 

oficial o ecológico (Połomski, M., & Wiatkowski, M. 2023), por lo tanto, es un componente 

esencial para la supervivencia y el desarrollo de las dinámicas poblacionales, sin embargo, 

en las últimas décadas las fuentes hídricas han sido afectadas en su disponibilidad debido a 

actividades antrópicas y al cambio climático, derivado de los cambios de temperatura y 

precipitación, lo cual impacta la demanda y el suministro de agua (Cheng, y otros, 2023). 

Adicionalmente, las condiciones morfológicas y de distribución de los cuerpos de agua 

tienden a variar con el paso del tiempo (Zhao & Wang, 2024) (Bacalhau, Neto, ́taux, ́-

Nguyen, & Moreira, 2022), por lo que es importante conocer y monitorear el volumen de 

almacenamiento disponible de estos cuerpos de agua, ya que es uno de las variables más 

representativas en la gestión de este tipo de recurso hídrico, previniendo situaciones de 

escasez y desabastecimiento del líquido vital en épocas de estiaje o posibles inundaciones en 

temporadas de lluvia comprendiendo la interacción entre la dinámica espacio-temporal del 

agua y el cambio climático (Bacalhau, Neto, ́taux, ́-Nguyen, & Moreira, 2022). 

 

Por lo anterior, es importante realizar un monitoreo de la dinámica del embalse artificial Las 

Parcelas, el cual por condiciones de orden público y conflicto armado sufrido en la zona en 

las décadas de los 80 y 90 presenta un vacío de información respecto a su llenado y operación, 

histórico de niveles y variación del espejo de agua (Beleño, Ayala, & Herrera, 2024) 

(Agudelo, 2022).Cabe resaltar que el embalse Las Parcelas, es actualmente la única fuente 

de agua factible que surte de agua por gravedad al sistema de acueducto del corregimiento el 

Tomate, evitando sobrecostos por bombeo frente a otras alternativas de la zona como lo es el 

recurso hídrico subterráneo. (Pérez, A. K. C, 2021). 

 

Con el fin de conocer el histórico de  variables morfométricas del embalse es importante 

acudir a la tecnología de información espacial o teledetección, la cual se ha convertido en 

uno de los medios más importantes a la hora de extracción de datos de la superficie terrestre 

(Cao, H., Han, L., & Li, L, 2022). Esta tecnología ha evolucionado rápidamente en los 

últimos años, aumentando tanto la cantidad de datos como la diversidad de sensores que 

adquieren las imágenes (Cheng, y otros, 2023). 

 

Para cumplir el objetivo de identificar y resaltar la zona acuática del embalse Las Parcelas en 

las imágenes  satelitales, se realizó un ajuste en el contraste y el brillo espectral de los datos 

referidos a cuerpos de agua, suprimiendo el brillo de los datos asociados a la vegetación y la 

tierra; por medio de herramientas que facilitan la recopilación de información, para  este caso 



 

en particular se utilizó Google Earth Engine (GEE), la cual es una plataforma en nube que 

contiene un gran conjunto de datos geoespaciales disponibles públicamente con el fin de 

procesarlas de una manera más eficiente (Zhao & Wang, 2024). 

 

En ese sentido, esta investigación tiene como objetivo, identificar el periodo de inicio del 

llenado del embalse artificial Las Parcelas, mediante el uso de imágenes de teledetección 

obtenidas de la misión Landsat y un modelo de elevación digital (DEM) de NASADEM 

(Kariminejad, N., Jafari, M., Domazetović, F., & Quesada-Román, A. 2024), con el fin de 

analizar los cambios en su capacidad hídrica a lo largo del tiempo. Estos cambios están 

condicionados a diferentes factores propios de la zona, como las costumbres que determinan 

en gran medida el consumo de agua de sus habitantes, así como las actividades económicas 

del corregimiento, las cuales se basan en la agricultura y explotación forestal (Vargas et al., 

2020) y finalmente, por patrones ambientales y meteorológicos como el ENOS que puede 

influir en el régimen de lluvias de la zona (Naranjo Bedoya, K., Aristizábal Giraldo, E. V., 

& Morales Rodelo, J. A., 2019). 

 

Esta investigación aporta en el conocimiento de la dinámica del comportamiento de las 

características físicas del embalse artificial Las Parcelas, teniendo en cuenta los fenómenos 

atmosféricos, lo que contribuye en la predicción de la disponibilidad de agua para el 

abastecimiento de la población y adicionalmente, con el estudio de imágenes satelitales con 

sus diferentes técnicas de teledetección que permiten la recolección de información sobre el 

terreno a diferentes escalas, permitiendo así investigaciones en profundidad de la superficie 

de la Tierra (Kislik, C., Dronova, I., Grantham, T. E., & Kelly, M., 2022), por medio del uso 

de herramientas tecnológicas como GEE, que permite analizar y procesar datos geoespaciales 

a escala planetaria (Gorelick et al. 2017),  podemos conocer información histórica importante 

para el desarrollo de las comunidades. 

 



 

2. Marco teórico 

La disponibilidad de agua y las características de las fuentes hídricas dependen en gran 

medida de los patrones de precipitación (Banerjee, y otros, 2024); con el fin de conocer la 

influencia histórica en el comportamiento de las distintas características espectrales de los 

cuerpos de agua y su distribución espacial, se utiliza la teledetección por satélite, la cual se 

caracteriza por su rapidez y simplicidad (Zhao & Wang, 2024), además, de que son cruciales 

para la gestión eficaz del agua en regiones en desarrollo con escasez de datos (West et al., 

2019).  

De acuerdo con (Zhao & Wang, 2024) en los últimos años, se han llevado a cabo 

investigaciones sobre identificación de masas de agua superficiales mediante técnicas de 

teledetección y se han propuesto diferentes modelos de extracción, como: la banda única que 

suele utilizar bandas de infrarrojo cercano e infrarrojo medio que se caracterizan por su 

simplicidad y facilidad de operación. En comparación con el método de banda única, los 

índices espectrales multibanda se han utilizado ampliamente, ya que construyen modelos 

matemáticos a través de operaciones con bandas para mejorar los cuerpos de agua y suprimir 

las características no acuáticas (Zhao & Wang, 2024), sin embargo, de acuerdo con la 

clasificación de la teledetección en el caso de ser supervisada puede ser un proceso tedioso, 

ya que se realiza por medio de un análisis visual con el propósito de identificar componentes 

del paisaje, basándose en criterios de tono, color y textura, pero su costo es menor que en un 

análisis digital (Luna, I. J. C., Murguía, M. L., Pati, F. M., & Valdivia, H. S., 2018). 

Como lo mencionan los autores del artículo “Surface water monitoring from 1984 to 2021 

based on Landsat time-series images and Google Earth Engine” los índices de agua 

comúnmente utilizados son: el Índice de Agua de Diferencia Normalizada (NDWI), el Índice 

de Agua de Diferencia Normalizada Modificada (MNDWI), el Índice de Extracción 

Automatizada de Agua (AWEI), el Índice de Agua 2015 (WI2015) y el Índice de Agua 

Multibanda (MBWI). Destacándose los índices AWEI y WI2015, ya que se ha demostrado 

en algunos estudios que tienen una mejor precisión (Zhao & Wang, 2024). 

Con el fin de aplicar las técnicas de teledetección descritas, es posible utilizar plataformas de 

código abierto como Google Earth Engine, la cual ofrece servicios fáciles de usar y métodos 

sostenibles para el análisis espacial a gran escala (Demir, Bas, & ayi˘git, 2024). Como lo 

destacan (Fernando & Senanayake, 2024) “GEE no solo proporciona accesibilidad a una 

amplia gama de conjuntos de datos satelitales y espaciales, sino que también asigna recursos 

computacionales para analizar registros de tiempo de los datos y la posibilidad de programar 

de acuerdo con los requisitos del usuario”. 

Otras de las características principales de GEE, es que no solo permite integrar múltiples 

fuentes e imágenes de teledetección global a múltiples escalas, sino que también permite el 

análisis de imágenes de banda completa y alta intensidad (Liang, Chen, Song, Sun, & Yang, 

2023). Todas estas características la han convertido en una herramienta útil y versátil, 

aplicable en diferentes campos de la ingeniería. Algunos ejemplos que destacan (Bajaj, y 

otros, 2024), es la utilidad de Google Earth Engine para abordar desafíos ambientales y 

proporcionar información basada en el monitoreo de los cambios en la cobertura del suelo 

(Song, y otros, 2018), evaluar las tasas de deforestación (Hansen, y otros, 2013), rastreo del 



 

crecimiento urbano (Li et al., 2021), mapeo de la dinámica de los incendios forestales (Cohen 

et al., 2017) e incluso predecir brotes de enfermedades (Funk et al, 2018). Además, facilita 

la toma de decisiones oportunas en respuesta a los cambios del entorno por su capacidad para 

procesar y analizar imágenes satelitales durante períodos de tiempo prolongados; todas estas 

cualidades, lo convierten en una herramienta valiosa para estudiar ecosistemas dinámicos 

(Bajaj, y otros, 2024). 

Aunque autores como (Pinkeaw, Boonrat, Koedsin, & Huete, 2024), mencionan que GEE se 

puede aplicar como una combinación de herramientas automatizadas cuando tenemos 

grandes cantidades de datos, junto con refinamiento manual para producir resultados precisos 

y mapas confiables, logrando un equilibrio entre ambas, se pueden incurrir en errores 

involuntarios, en el caso de la interpretación visual la cual requiere de experiencia, por lo que 

es factible realizar una clasificación errónea (Yang, y otros, 2024). Como también es el caso 

de las imágenes a gran escala que se capturan en su mayoría en diferentes períodos, por lo 

tanto, pueden tener variaciones temporales y espaciales, lo que hace que el umbral sea 

susceptible a factores de subjetividad del observador (Zhao & Wang, 2024). 

Por otra parte, con el fin de conocer las características de los cuerpos de agua, entre ellas el 

volumen, es importante tener en cuenta los datos de altimetría satelital, los cuales dependen 

de los sensores, las frecuencias de muestreo, de las propiedades del terreno de la zona y de 

las nubes sobre la región de estudio. Es posible que los anteriores factores deriven en el 

resultado de valores atípicos (Han, Kim, Mehrotra, & Sharma, 2024).  

Los datos de altimetría y las características del terreno como contorno de líneas, pendiente y 

aspecto del terreno, pueden ser extraídos de un modelo de elevación digital (DEM), el cual 

está hipotéticamente libre de árboles, edificios u otros objetos no terrestres, que proporcionan 

la base para el modelado y el análisis de información espacio-topográfica (Villarreal, C. A., 

Garzón, C. G., Mora, J. P., Rojas, J. D., & Ríos, C. A., 2022). y que utiliza diferentes técnicas 

como la fotogrametría, los sensores o estudio de campo, cada una con sus ventajas y 

desventajas. Los DEM son aplicados en áreas de la hidrología para la estimación de la 

capacidad de un embalse, para la evaluación de la probabilidad de deslizamientos de tierra, 

la modelación de aguas subterráneas, la cartografía de zonas propensas a inundaciones, etc 

(Elsonbaty, Fawzy, Moghazy, Rashed, & Hamed, 2023). Como es el caso de las imágenes 

satelitales, muchos DEM también se pueden obtener de manera libre, sin embargo, cuando 

se requiere información con una resolución a gran escala es bastante difícil de adquirir, 

debido a su alto costo (Huang, y otros, 2023). 



 

3. Objetivos 

3.1 Objetivo General 

Identificar el periodo de inicio del llenado del embalse artificial Las Parcelas, 

mediante el uso de imágenes de teledetección obtenidas de la misión Landsat y un 

modelo de elevación digital (DEM) de NASADEM, con el fin de analizar los cambios 

en su capacidad hídrica a lo largo del tiempo. 

3.2 Objetivos Específicos 

• Determinar el periodo de inicio de llenado del embalse artificial las parcelas 

en el municipio de San Pedro de Urabá mediante el análisis de imágenes satelitales 

de la misión Landsat-4, Landsat-5, Landsat-7, Landsat-8 y la aplicación del Índice de 

Diferencia Normalizada de Agua (NDWI), analizando las variaciones en la superficie 

del agua a lo largo del tiempo. 

• Analizar el cambio en el espejo de agua mensual a partir de imágenes 

satelitales desde enero del  2004 hasta octubre del 2024, y su correlación con el 

volumen de almacenamiento del embalse artificial las parcelas, en el municipio de 

San Pedro de Urabá utilizando un modelo de elevación digital (DEM) obtenido de la 

fuente NASADEM.  

• Encontrar una relación entre la cota y el volumen de agua contenido para el 

embalse artificial Las Parcelas en el municipio de San Pedro de Urabá, utilizando el 

modelo de elevación digital (DEM) de NASADEM y herramientas de 

geoprocesamiento espacial. 



 

4. Metodología 

El análisis realizado para determinar el volumen del cuerpo de agua superficial fue 

desarrollado en tres etapas principales:  

• Obtención y preprocesamiento de imágenes satelitales con aplicación del índice 

NDWI para la identificación de áreas de agua.  

• Obtención y preprocesamiento de modelo de elevación digital (DEM). 

• Procesamiento de información y cálculo del volumen mediante modelo de elevación 

digital (DEM) obtenido de la fuente NASADEM e imágenes satelitales con aplicación del 

índice NDWI fuente Landsat. A continuación, se detallan los métodos empleados en cada 

una de estas etapas. 

4.1 Área de Estudio y Conjuntos de Datos 

4.1.1 Área de Estudio 

La represa artificial Las Parcelas, se encuentra localizado en las coordenadas (76°23'5.20"O;   

8°26'21.53"N) del Sistema WGS84 en el corregimiento El Tomate, municipio de San Pedro 

de Urabá, departamento de Antioquia, Colombia. Este corregimiento limita al norte con 

Arboletes, al oriente y al sur con el corregimiento de Santa Catalina, y al occidente con el 

distrito de Turbo. 

4.1.2 Conjunto de Datos 

Para el desarrollo del análisis presentado en este documento, se emplearon las siguientes 

misiones espaciales para la adquisición de imágenes satelitales y la generación de modelos 

de elevación digital: 

4.1.2.1 Imágenes satelitales – Lansant. 

Landsat, un programa conjunto del USGS y la NASA, ha estado observando la Tierra 

continuamente desde 1972 hasta la actualidad. Hoy en día, los satélites Landsat obtienen 

imágenes de toda la superficie de la Tierra con una resolución de 30 metros aproximadamente 

una vez cada dos semanas, incluidos datos multiespectrales y térmicos (Amani et al., 2022). 

4.1.2.2 Modelo de Elevación Digital – NASADEM. 

Los Modelo de Elevación Digital (DEM), debido a los avances en la tecnología informática 

y satelital, ha contribuido significativamente a la precisión de la mayoría de los modelos 

hidrológicos (Tran et al., 2022), NASADEM es una reprocesamiento de datos SRTM con 

resolución de 30 metros, con precisión mejorada al incorporar datos auxiliares de los 

conjuntos de datos ASTER GDEM, ICESat GLAS y PRISM. Las mejoras de procesamiento 

más significativas implican la reducción de vacíos mediante un mejor desenvolvimiento de 

fases y el uso de datos ICESat GLAS para el control. En general, NASADEM presenta un 

buen desempeño  para la evaluación de características de red de ríos y cuencas hidrográficas 



 

(Nguyen et al, 2022), por lo que es un elemento esencial en la determinación de las 

características morfológicas e hidrológicas del embalse artificial Las Parcelas. 

4.2 Obtención del Modelo de Elevación Digital (DEM) 

El modelo de elevación digital (DEM) utilizado en este análisis fue obtenido a partir de la 

fuente NASADEM para el año 2000. Este satélite proporciona datos de radar de apertura 

sintética (SAR) en banda L, lo que permite generar modelos de elevación con alta precisión, 

incluso en áreas de difícil acceso y bajo condiciones meteorológicas adversas. El proceso 

para la obtención del DEM fue realizado mediante un código Javascript en el entorno Google 

Earth Engine   (Capolupo et al.,2021) de manera simplificada como se presenta a 

continuación: 

Figura 1. Código util izado en Google Engine para la obtención del modelo 

de elevación digital (DEM).  

 

4.3 Obtención de Imágenes Satelitales – Lansat 

Las imágenes satelitales utilizadas fueron obtenidas de la misión Landsat. Se generaron 

composiciones anuales desde 2004 hasta 2024, así como composiciones mensuales en el 

mismo periodo. 

Para este estudio, se emplearon imágenes específicamente de los satélites Landsat 4 

"LANDSAT/LT04/C02/T1_L2", Landsat 5 “LANDSAT/LT05/C02/T1_L2”, Landsat 7 

"LANDSAT/LE07/C02/T1_L2" y Landsat 8 "LANDSAT/LC08/C02/T1_L2"), debido a su 

alta resolución espacial (30 m) y su disponibilidad temporal para la región de estudio. Las 

imágenes obtenidas fueron preprocesadas para corregir efectos atmosféricos y geográficos, 

como la corrección radiométrica y la ortorectificación, utilizando las herramientas 

disponibles en Google Earth Engine.  



 

Para identificar y delimitar las áreas correspondientes a cuerpos de agua superficial, se utilizó 

a través las herramientas disponibles en Google Earth Engine el Índice de Diferencia 

Normalizada de Agua (NDWI, por sus siglas en inglés) un indicador espectral ampliamente 

utilizado para la detección de agua en imágenes satelitales, sobre las imágenes compuestas 

de interés. (Liu et al., 2018) 

Cálculo del NDWI: El índice NDWI fue calculado para cada una de las imágenes compuestas 

generadas a partir de las bandas verde y de infrarrojo cercano (NIR) de las imágenes Landsat, 

utilizando la siguiente fórmula: 

𝑁𝐷𝑊𝐼 =
𝐺𝑅𝐸𝐸𝑁 − 𝑁𝐼𝑅

𝐺𝑅𝐸𝐸𝑁 + 𝑁𝐼𝑅
 

Los Raster .TIF generados a partir del cálculo del índice NDWI de las imágenes satelitales 

utilizadas mediante Google Earth Engine (GEE), como se presenta a continuación: 

Figura 2. Código util izado en Google Engine para la obtención del modelo 

de imágenes satelitales de la misión Lansat.   

 
 



 

 

4.4 Post Procesamiento DEM 

4.4.1 Post Procesamiento DEM 

La producción de líneas de contorno de alta precisión es importante para la determinación de 

los métodos tradicionales de volumen de contorno (Du et al.,2023). Una vez descargados de 

manera local el archivo DEM para el año 2000, realizando la previa verificación de la no 

existencia del embalse artificial ni demás interferencias como cuerpos de agua u otros, 

mediante la herramienta ARCGIS PRO 3.3, se procedió con la generación de líneas de 

contorno mediante la herramienta de arctoolbox > 3D Analisys Tools> Raster > Surface > 

Contour para la generación de curvas de nivel basadas en el DEM de referencia.  

Una vez generadas las curvas de nivel mediante la herramienta Contour de ArcGis Pro 3.3, 

se procedió con la generación de archivo TIN (red irregular de triángulos) mediante la 

herramienta de arctoolbox > 3D Analisys Tools> Raster > TIN Dataset > Create TIN. A 

continuación, se muestra el procedimiento en la herramienta model builder de Arcgis Pro 

3.3.arctoolbox > 3D Analisys Tools> Raster > TIN Dataset > Create TIN. A continuación, 

se muestra el procedimiento en la herramienta model builder de Arcgis Pro 3.3. 



 

 

4.4.2 Post Procesamiento de Imágenes NDWI 

Una vez descargados de manera local los archivos ráster con el índice NDWI para las 

imágenes compuestas de interés mediante la herramienta ARCGIS PRO 3.3, se procedió con: 

4.4.2.1 Determinación de Imágenes Lansat Funcionales. 

En el análisis de imágenes satelitales, es crucial seleccionar aquellas que cumplan con los 

requisitos específicos del estudio. Las imágenes útiles se definieron como aquellas que 

proporcionan una cantidad adecuada de información, destacándose por su alta calidad y una 

baja interferencia de factores como la nubosidad, la contaminación atmosférica u otros 

elementos que puedan comprometer la precisión y fiabilidad de los datos. Esta revisión fue 

realizada de manera manual identificando los ráster compuestos con suficientes datos para 

ser post procesadas, para los casos en los que no existan imágenes compuestas funcionales 

con periodicidad mensual, pero la imagen compuesta con periodicidad anual es funcional, se 

hace uso de esta última bajo la figura de mes de diciembre del respectivo año. 

4.4.2.2 Calculo Área de Lámina de Agua en Función del Tiempo. 

Una vez identificados los ráster a ser post procesados, se procedió a utilizar el Software 

ArcGis Pro 3.3, mediante la herramienta del arctoolbox > Spatial Analysis Tools > Reclass 

> Reclassify para la generación de nuevos ráster con dos únicos valores según el conjunto de 

datos definido para cada ráster. A continuación, se muestra el procedimiento en la 

herramienta model builder de Arcgis Pro 3.3. 

 

Una vez reclasificados los raster con el índice NDWI para cada una de las imágenes 

compuestas seleccionadas, se hizo uso de la herramienta de arctoolbox > Conversion Tools 

> From Raster > Raster to Polygon, generando los shapefile tipo polígonos como se muestra 

a continuación. A continuación, se muestra el procedimiento en la herramienta model builder 

de Arcgis Pro 3.3. 

 

En los archivos Shapefile de tipo polígono generados a partir del paso anterior, se hizo uso 

de la herramienta arctoolbox > Data Management Tools > Feature >Calculate Geometry 

Attributes para crear la columna de área y calcular su valor en unidad de Hectárea para cada 

uno de los ráster seleccionados. A continuación, se muestra el procedimiento en la 

herramienta model builder de Arcgis Pro 3.3. 



 

 

Una vez terminado los anteriores pasos, se procedió a realizar eliminación manual de los 

campos o atributos de los shapefile de tipo polígono que no representaban la lámina de agua 

del embalse objeto del análisis. 

 

4.4.3 Cálculo de Volumen de Agua del Embalse en Función del Tiempo 

Una vez definido el modelo de elevación digital, se procede con la creación de un shapefile 

tipo polígono que represente el área máxima posible de la lámina de agua o cuenca 

hidrográfica del punto de interés, esto con el objetivo de que al momento de terminar el 

volumen del cuerpo de agua no genere errores de sobredimensionamiento de volumen. Para 

esto, se hace uso de la herramienta Create Feature Class del software Arcgis Pro 3.3. A 

continuación, se muestra el procedimiento en la herramienta model builder de Arcgis Pro 3.3. 

 

Una vez determinados el archivo TIN generado a partir del modelo de elevación digital y el 

shapefile de referencia, se hace uso de la herramienta arctoolbox 3D Analyst Tools > Area 

and Volume > Polygon Volume para determinar el volumen entre el polígono y el TIN 

ingresados para múltiples cotas de elevación. A continuación, se muestra el procedimiento 

en la herramienta model builder de Arcgis Pro 3.3. 

 



 

5. Análisis y resultados 

5.1 Determinación del Periodo de Tiempo de Inicio de Llenado Embalse Artificial las 

Parcelas – Análisis de Imágenes Satelitales de Landsat y NDWI 

Durante la etapa de preprocesamiento de las imágenes satelitales de la misión Landsat en la 

Plataforma Google Earth Engine, se encontraron 252 imágenes compuestas con periodicidad 

mensual y 12 imágenes compuestas con periodicidad anual. La principal dificultad 

encontrada en este procedimiento fue la falta de información del píxel de las imágenes 

originada por la alta cobertura de nubes en la región, haciendo que muchas de las fotografías 

satelitales analizadas contarán con datos parciales o no suficientes para el análisis propuesto 

como se muestra en la Figura 3. 

Figura 3.Imágenes Satelitales Lansat con índice NDWI no funcionales .  

   

2004 2005 2023 

Durante el análisis de las imágenes satelitales con periodicidad anual, se identificó la 

existencia del cuerpo de agua desde el año 2005, mientras que para la periodicidad mensual 

se identificó que el primer mes donde se evidencia la existencia del cuerpo de agua obedece 

al mes de mayo del año 2005 como se muestra en la Figura 4. 

Figura 4. Presencia de lámina de agua de embalse las parcelas en el  tiempo.  

    

Diciembre 2004 Mayo 2005 Abril 2005 Julio 2023 

A partir del mes de mayo del año 2005, se encontraron 44 imágenes funcionales que contaban 

con presencia de la lámina de agua del embalse y con la calidad suficiente para su posterior 

procesamiento. Se presenta en la Tabla 1 la relación entre imágenes con índice NDWI 

funcionales que cuentan con la presencia del cuerpo de agua Las Parcelas. 

 

 



 

Tabla 1. Funcionalidad de imágenes satelitales con índice NDWI y presencia de cuerpo de 

agua Las Parcelas. 

 

5.2 Análisis del Volumen de Agua usando el DEM de NASADEM e Imágenes 

Satelitales Lansant con Índice NDWI 

Para el análisis del volumen de agua del embalse artificial Las Parcelas, se usó tanto del 

modelo digital de elevación como de las imágenes satelitales con índice NDWI, a 

continuación, se describe lo encontrado: 

5.2.1 Análisis del Modelo de Elevación Digital DEM 

El análisis del volumen del embalse artificial fue realizado mediante el uso un DEM para el 

año 2000 de NASADEM y sin considerar la geometría de la represa artificial construida para 

el represamiento del agua ni el efecto que conlleva el arrastre, sedimentación y depósito de 

material en el fondo del embalse como se muestra a continuación en la Figura 5. 

 



 

Figura 5 .  Superficie del  Modelo de elevación digital del  embalse las 

parcelas año 2000.  

 

Mediante el uso del software de ArcGIS Pro 3.3 como fue descrito en la metodología 

anteriormente, se determinó el volumen (m3) del embalse con relación a la cota de la lámina 

de agua (m.s.n.m) como se muestra en el, el cual se identificó que la línea de tendencia de 

los datos denominada como Series1 cuenta con comportamiento polinómico de grado 2 con 

R2 de 0.9996 descrito por la ecuación: 

          𝑉𝑜𝑙𝑢𝑚𝑒𝑛 (𝑚3) = 82.87𝑥2 − 5598.4𝑥 + 83736 

Gráfico 1 Relación Cota vs Volumen Embalse Artificial Las Parcelas.  

 

5.2.2 Evolución Temporal del Volumen del Embalse Artificial Las 

Parcelas (2005 – 2024) 

Una vez determinadas las imágenes satelitales con índice DWI funcionales para el análisis 

como se mostró en la Tabla 1, se determinó el volumen correspondiente del embalse para 

cada uno de los períodos cubiertos, dando como resultado la Tabla 2 que se presenta a 

continuación: 

 

 



 

Tabla 2.  Parámetros de análisis del embalse artificial  Las Parcelas.  

 

 

La teledetección satelital es una poderosa herramienta para mapear zonas inundadas (Notti 

et al.,2018), El análisis de los datos de la imagen satelital con NDWI permitió identificar con 

precisión las etapas iniciales del llenado del embalse, iniciando entre el periodo de enero del 

2005 y mayo del 2005, mes para el cual el embalse artificial ya contaba con un volumen de 

agua aproximado de 20569 m3, alcanzando su primer pico significativo en el mes de octubre 

de 2013 con 616931 m3.  El resultado obtenido es concordante con la afirmación de que la 

teledetección puede ser utilizada para determinar una posible ubicación para la construcción 

de un embalse de agua (Khojiakbar et al.,2019). A partir del año 2013 y con base a los meses 

evaluados, el volumen crítico mínimo del embalse artificial se presentó en diciembre del 

2016 con 334770 m3 y su volumen máximo a julio de 2023 con 791832 m3 como puede 

apreciarse en la Figura 6 que se presenta a continuación: 

 



 

 

Figura 6. Evolución de la lámina de agua del embalse artificial  Las Parcelas 

en el  tiempo.  

 

Mientras que en el Gráfico 2 puede observarse el comportamiento del volumen en unidad de 

metros cúbicos desde el mes de mayo del año 2005 hasta el mes de octubre del año 2024 

como se presenta a continuación: 

Gráfico 2.Variabilidad de volumen del embalse artificial las parcelas año 

2005 - 2024.  

 

 



 

6. Conclusiones 

● El análisis espacial de las variaciones en el volumen de agua se llevó a cabo utilizando 

el modelo de elevación digital (DEM) de NASADEM con una resolución de 30 metros y los 

datos de las imágenes satelitales de la misión Landsat con una resolución de 30 metros, junto 

con el índice NDWI. Este enfoque permitió calcular la evolución temporal de la superficie 

inundada, el volumen y la altura de la lámina de agua desde mayo de 2005 hasta octubre de 

2024. Los resultados indican que el periodo de llenado del embalse comenzó entre enero y 

mayo de 2005. Además, se determinaron los volúmenes y cotas máximas y mínimas de la 

lámina de agua durante el periodo evaluado. El volumen crítico mínimo del embalse artificial 

se registró en diciembre de 2016, con 334770 m³ y una cota de 108.8 m.s.n.m, mientras que 

el volumen máximo se alcanzó en julio de 2023, con 791832 m³ y una cota de 112 m.s.n.m. 

 

● El análisis del modelo de elevación digital (DEM) de NASADEM permitió establecer 

una relación matemática entre el volumen de agua del embalse artificial Las Parcelas y la 

cota de la lámina de agua, sin considerar la geometría de la represa ni los efectos derivados 

de procesos como el arrastre, la sedimentación y el depósito de material en el fondo del 

embalse. La ecuación polinómica de segundo grado obtenida es la siguiente: 

 

Volumen (m³) = 82.87y² - 5598.4y + 83736    R2 = 0.9996 

Donde y representa la cota de la lámina de agua en m.s.n.m. Esta relación proporciona una 

herramienta útil para estimar el volumen del embalse en función de la cota, lo que facilita su 

monitoreo y gestión eficiente a lo largo del tiempo. Sin embargo, es importante tener en 

cuenta que el modelo no incorpora factores geométricos ni dinámicas de sedimentación, lo 

que podría influir en la precisión de los resultados en condiciones específicas. 

● Este enfoque metodológico ofrece una herramienta integral para analizar la evolución 

de embalses artificiales, empleando técnicas avanzadas de teledetección y análisis 

geoespacial.  Este tipo de análisis resulta crucial para optimizar la gestión de los recursos 

hídricos, la planificación de infraestructuras y la sostenibilidad ambiental, especialmente en 

regiones donde los embalses artificiales desempeñan un papel esencial en la regulación y 

distribución del agua. Una mejora en la resolución de las imágenes satelitales y el modelo de 

elevación digital permitiría obtener resultados más detallados y precisos en el análisis del 

embalse, ya que una mayor resolución facilita la identificación de cambios más sutiles en la 

superficie del agua, mejorando la capacidad para monitorear su evolución temporal y estimar 

de manera más exacta el volumen de agua almacenado. 
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